
 

温度升高和游离余氯对泥蚶的氧化胁迫效应
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摘要：为了研究核电站温排水污染对水生动物长期胁迫的影响，实验通过室内模拟核电站
温排水的游离余氯残留和温升效应，研究了不同温度和不同游离余氯浓度耦合下对泥蚶的
氧化胁迫效应。设置水温为 19和 29 °C，游离余氯浓度分别为 0.33和 6.66 mg/L，进行为
期 20 d的胁迫实验。结果显示：①单一温升条件下，温度升高可以显著影响泥蚶 ROS水
平。温度越高，ROS水平越高。② 0.33 mg/L浓度组泥蚶 ROS水平和 DNA损伤在第 20天
时显著升高，19和 29 °C下分别为对照组的 2.2、2.9倍和 1.8、2.2倍；细胞活性、SOD活
性、ATP酶活性均下降；6.66 mg/L浓度组 ROS水平在第 20 天时显著上升，19和 29 °C下
分别为对照组的 6.2、3.6倍，DNA损伤增加，细胞活性、血细胞吞噬率和 ATP酶活性下
降，SOD酶活性在第 20天、29 °C时降至最小值 (36.4±8.4) U/(mg·prot)。③双因素方差分
析结果显示，水温和游离余氯对泥蚶 ROS水平、DNA损伤、血细胞吞噬活性、ATP酶活
性具有显著交互作用。研究表明，游离余氯能够显著增加泥蚶 ROS水平和 DNA损伤，温
度升高和游离余氯复合暴露对泥蚶造成更大的胁迫压力，影响了其机体内氧化响应相关生
理过程，余氯排放海域夏季相比冬季会对泥蚶产生更大的氧化胁迫。本研究可为温度升高
和游离余氯复合污染中的海洋生物氧化胁迫毒性研究提供参考，并且为生态风险评估提供
科学依据。
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我国沿海地区核电站造成的环境污染主要表

现为温升和余氯，核电站原子核裂变产生的能量

只有 30%~35%转变为电能，大量的废热通过冷却

水排放到环境中[1]，张露等[2] 指出，温排水排水口

附近 0.1~0.2 km2 的范围会引起 7 °C的温升，2~

3 km2 范围内会引起 4 °C的温升。氯化在 20世纪

初就作为城市供水、生活污水及工业废水的消毒

手段 [3]。随着电力工业的发展，氯化被广泛用于

核电站冷凝凝结系统的生物污损防治，氯使用之

后又排放于水体中。游离余氯具有强氧化性，游

离余氯污染会对海洋生物产生一系列有害的化学

作用，包括通过增加生物体内活性氧或自由基类

物质的浓度，导致机体氧化系统和抗氧化防御系

统失衡，从而引起生物体内强烈的氧化响应，甚

至造成显著的毒性影响[4]。

从 20世纪 60年代以来，国外研究者就对温
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度升高和游离余氯的生态效应开展了大量研究[5-7]。

我国自 80年代以来也开展了相关研究[8-10]。朱英[11]

研究了典型家用消毒剂对稀有鮈鲫 (Gobiocypris
rarus) 毒性及酶活性的影响，指出消毒剂 (有效成

分为次氯酸钠，含量 1.5%) 暴露浓度为 5.6~18
mg/L胁迫 28 d时，SOD活性显著被抑制。Valar-
mathi等[12] 分别以氯化铜和氯的LC50 值的 1/10和 1/3
研究了相手蟹  (Sesarma quadratum) 耗氧和排氨，

发现第 1、7、14和 21天时，氯化铜和氯对相手

蟹耗氧率和排氨率的抑制效应随着浓度的增加而

加强。晁敏等[13] 发现温度和余氯对黑棘鲷 (Acant-
hopagrus schlegelii)胚胎孵化抑制具有协同毒性效

应。叶利兰等[14] 指出，含氯制剂大量使用不仅会

对单一水生物种造成影响，对水生态系统的群落

结构和生态演替也会产生影响，进而影响水生态

系统中的物质循环，最终破坏水生态系统的平衡。

Cao等 [4] 指出，即使在极低浓度的次氯酸钠浓度

下，铜绿微囊藻 (Microcystis aeruginosa)和小球藻

(Chlorella vulgaris)细胞中的氧化应激也会增加。

泥蚶 (Tegillarca granosa) 属软体动物门 (Mol-
lusca) 双壳纲 (Lamellibranchia) 列齿目 (Taxodonta)
蚶科 (Arcidae) 泥蚶属 (Tegillarca)，是一种广温性

双壳贝类，一般分布在我国山东以南沿海地区。

泥蚶长期栖息在固定的水域，运动能力较差，容

易暴露在海洋污染物中，无选择性的滤食特性使

它们易受污染物的长期影响。目前，国内外对余

氯的研究主要集中在对生物个体的急性毒性上[8, 10, 13]，

本研究从细胞和分子水平上研究温度升高和游离

余氯对以泥蚶为代表的滩涂贝类长期胁迫的氧化

响应，包括活性氧、细胞活性、细胞吞噬效率、

DNA损伤、SOD活性和 ATP酶活性等。以期为

揭示海洋生物在温度升高和游离余氯复合污染中

而导致氧化毒性提供线索，并且为生态风险评估

提供科学依据。

 1    材料与方法

 1.1    实验材料

实验所用的 2龄泥蚶采自浙江省台州市三门

县 (28°53′N，121°36′E)，选择健康，规格一致的

个体，初始湿重为 (10.54±1.46) g、壳长为 (21.66±
1.65)  mm、 壳 宽 为  (20.69±1.03)  mm、 壳 高 为

(24.46±1.27) mm，用高锰酸钾浸泡 5 min消毒后放

入水箱暂养，暂养期间充气并升温达到实验所需

温度  (19、29 °C)，初始温度为 15 °C。将泥蚶分

为 2批，每天升温 2 °C，一批 2天时达到 19 °C
之后并一直在该温度下暂养，另一批 7天时达到

29 °C，暂养 3 d，两批同时进行实验。每天早上

9:00换水 1次，换水量为 100%，投喂适量的亚心

型扁藻 (Platymonas subcordiformis)。
实验所用海水为浙江省海洋水产养殖研究所

清江基地经 24 h以上沉淀和砂滤后的乐清湾海域

(121°E，28°N) 天然海水。经检测，海水本底不含

余氯，每次换水前 2 h，将实验海水进行预热处理，

达到实验所需的温度梯度 (19 °C、29 °C)。

 1.2    实验设计

用蒸馏水将次氯酸钠 (NaClO分析纯) 配置成

浓度为 1.5 mg/mL的母液，现配现用，通过预实

验获得 2龄泥蚶的游离余氯 96 h半致死浓度为

66.6  mg/L，由此设置长期胁迫实验浓度为 0.33
mg/L (0.005×LC50) 和 6.66 mg/L (0.1×LC50)，以砂

滤后的海水为空白对照。结果展示中，将 0.33
mg/L作 为 低 浓 度 组 ， 用 FRC1表 示 ； 将 6.66
mg/L作为高浓度组，用 FRC2表示。我国东海近

岸水域冬季和夏季平均水温分别约为 15和 25 °C，
我国《海水水质标准》 (GB3097—1997)[15] 中规定：

“第三类、第四类海域人为造成的海水温升不超过

当时当地的 4 °C”，故本实验设置 4 °C的温升，

即以 19、29 °C分别模拟冬夏两季温升情况。每

个实验组设 3个平行，进行为期 20 d的升温与游

离余氯胁迫实验。实验期间日常管理，保持充气、

每天全量换水，换水后，立即投喂适量的亚心型

扁藻，待泥蚶摄食 1 h后再加入游离余氯母液，

并保持温度在 (19.0±0.5) °C和 (29.0±0.5) °C。

 1.3    样品采集及处理

每个实验组投放 24只泥蚶，在胁迫后第 1、
10、20天进行取样，从每个实验组中随机挑选 6
只泥蚶，每个平行取 2只。先用 0.1 mol/L的磷酸

缓冲液 (PBS，pH 7.4) 冲洗贝壳表面，然后用 200
μL的移液枪从泥蚶的外套膜腔中抽取血淋巴，每

只泥蚶约取 600 μL，用于测定活性氧、细胞活性、

细胞吞噬率和 DNA损伤；取泥蚶内脏团组织，用

生理盐水冲去表面血渍，每只泥蚶内脏团约为 0.2
g，擦拭干后保存于 1 mL冻存管，液氮速冻后置

于−80 °C保存，用于酶活性的测定。实验过程中

操作人员严格遵守动物实验伦理规范，并按照相
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关的规章制度执行。

 1.4    实验方法

 余氯测定方法　　采取法国 PONSEL便携式

水质分析仪 (Multy8302) 及其配套试剂测定海水中

的余氯含量  (国家环境保护标准 HJ586—2010，
DPD法，量程 0.1~6.0 mg/L)。将市售次氯酸钠溶

液 (A501944-0500，生工生物工程上海股份有限公

司) 用蒸馏水稀释 105 倍后，用便携式水质分析仪

(Multy8302) 测得浓度为 (1.50±0.02) mg/L，即将市

售次氯酸钠原液稀释 100倍作为母液，母液浓度

为 1.50×103 mg/L。设置实验浓度梯度为 0.33 mg/L
和 6.66  mg/L，每天换水时分别添加 6.60  mL和

133.2 mL母液 (实验水体为 30 L)。
 活性氧的测定　　活性氧含量的测定采用

DCFH-DA荧光法，所用试剂盒购于碧云天生物科

技有限公司。实验步骤按照说明书进行，采用荧

光显微镜 (Eclipse 80i，Nikon) 镜检、拍照。图片

用 ImageJ软件  (http://imagej.nih.gov/ij/) 进行测定

分析，具体分析步骤如下。

①安装后首先打开 ImageJ；
② 打开图片：File→open (热键为 Ctrl+O)；
③ 转换成 8 bit的灰度图：Image→Type→8-bit；
④ 黑白反转：Edit→Invert (热键为 Ctrl+Shift+

I)；
⑤ 校正光密度：Analyze→Calibrate，在弹出

界面的 Function选择 Uncalibrated OD，并在界面

左下方勾选 Global calibration，然后点击右下角的

OK；

⑥ 选择测量单位 (一般选择象素，如有明确

的比例，也可以选择相应单位 )：Analyze→Set
scale，点击后在弹出的界面中点击 click to Remove
Scale，并勾选 Global，最后点击 OK；

⑦ 选 择 测 量 项 目 ： Analyze→Set  Measure-
ments，在弹出界面中选择所需测量的项目 Area、
Integrated density，并勾选 Limit to threshold，选择

后点击 OK；

⑧ 选择测量域值：Image→Adjust→Threshold
(热键为 Ctrl+Shift+T)，滑动界面中间的滑块选择

适合的域值，使图片中的待测目标刚好全部被选

中，之后点击右下角的 Set；
⑨ 测量：Analyze→Measure  (热键为 Ctrl+M

或直接按M)；
⑩ 记录数据并计算：结果中的 Area为细胞

在图中的面积，IntDen是细胞的 IOD (光密度的总

和)。结果界面中的数据可以复制到 Excel等软件

中进行计算，同法测量多张图的平均光密度值后

进行半定量比较。

平均光密度 =
IntDen
Area

(1)

 细胞活性的测定　　采用 MTT法，所用试

剂盒购于碧云天生物科技有限公司 (C0009S)。实

验步骤按照说明书进行，并通过酶标仪 (Multiskan
Go，Thermofish) 测定 570 nm波长处的吸光值。

 血细胞吞噬率的测定　　血细胞吞噬率的测

定根据 Cima等 [16] 的方法并加以改进。取 100 μL
血淋巴与 100 μL阿氏液  (Solarbio)等比例混合，

再加入 1 μL荧光微球  (invitrogena)，混合均匀。

室温下放置 30 min后冰浴 (4 °C) 1 h终止反应，然

后加入 100 μL 2.5 %戊二醛，制作血涂片，进行

瑞氏染色。染色后的涂片置于 1  000×显微镜

(Eclipse 80i，Thermofish) 下观察，并统计吞噬率。

每个样本均随机统计 3~5次，每次随机选取 100
个以上的血细胞用于统计。

 DNA损伤的测定　　DNA损伤的测定采用

彗星实验 (Comet Assay)，又称单细胞凝胶电泳实

验  (SCGE)，所用试剂盒购自 Cell  Biolabs公司

(STA-351)。按照说明书进行实验，采用荧光显微

镜 (Eclipse 80i，Thermofish ) 观察玻片、拍照、存

取结果，用 ImageJ软件  (http://wsr.imagej.net/dis-
tros/) 分析泥蚶血细胞 DNA的彗星图片，测定彗

星的荧光强度 A 和尾的荧光强度 B 及拖尾长度 L。
每个试验样本均随机统计 3~5次，每次随机选取

100个以上的血细胞用于统计。采用以下公式对

DNA损伤进行计算：

DNA损伤 =
∑ B

A ×L

总细胞数
(2)

 酶活性的测定　　超氧化物歧化酶 (SOD) 的
测定采用黄嘌呤氧化酶法，三磷酸腺苷酶 (Na+/K+-
ATPase) 的测定采用化学比色法。以上所需试剂

盒 购 自 索 莱 宝 生 物 科 技 有 限 公 司  (BC0175、
BC0065)。样品总蛋白含量的测定使用碧云天

BCA试剂盒 (P0012)。
SOD活性的计算公式：

抑制百分率 = (DA空白−∆A测定)/∆A空白×
100% (3)

使样本抑制百分率在 30%~70%范围内
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SOD酶活性= [抑制百分率/
(
1−抑制百分率

)
×

V反总]/
(
V样×Cpr

)
×F (4)

式中，V反总表示反应总体积，0.2 mL；V样表示加

入反应体系中的样本体积，0.018 mL；Cpr表示样

本蛋白浓度，mg/mL；F 表示样本稀释倍数。

Na+/K+-ATP酶活性的计算公式：

ATP酶活性 = C标准管×
(
A测定管−

A对照管
)
/
(
A标准管−A空白管

)
×V总/

(
Cpr×

V样
)
/T (5)

式中，C 标准管表示标准管浓度，0.5 μmol/mL；
V总表示酶促反应总体积，0.25 mL；V样表示加入

样本体积，0.1 mL；T 表示反应时间，10 min。

 1.5    数据分析

所得数据使用平均值±标准差  (mean±SD) 表
示，以独立样本 t 检验分析空白对照组在不同温

度下的显著性差异。以单因素方差分析 One-Way
ANOVA检验相同温度下不同浓度组之间的显著

性差异。采用 SPSS 22.0统计软件的 Tukey氏或

Dunnett氏 T3多重比较方法分析不同处理组和空

白组之间的差异显著性，当 P<0.05时统计具有显

著差异。以双因素方差分析 Two-Way  ANOVA
(SPSS 22.0软件) 检验温度升高、游离余氯这两个

因素相互作用是否显著影响泥蚶的氧化胁迫效应，

P<0.05为差异显著。而后采用 Origin Pro 2019软

件进行画图。

 2    结果

 2.1    温度升高对泥蚶氧化响应指标的影响

独立样本 t 检验结果表明，在第 1和 10天，

温度升高对泥蚶 ROS水平无显著影响  (P>0.05)
(表 1)；在第 20天，温度升高对泥蚶 ROS水平有

显著影响  (P<0.05)。温度越高，ROS水平越高。

第 1、10和 20天随着水温升高，泥蚶血细胞吞噬

率均有上升趋势，但结果表明温度升高对泥蚶血

细胞吞噬率均无显著影响 (P>0.05)。在第 1、10
和 20天，温度升高对泥蚶细胞活性、DNA损伤、

SOD活性、ATP酶活性均无显著影响 (P>0.05)。
 

表 1    独立样本 t检验：温度升高对泥蚶氧化响应指标的影响

Tab. 1    Independent-sample t tests: effect of temperature rise on oxidative response indexes of T. granosa

氧化响应指标
oxidative response index

取样时间/d
sampling time 19 °C 29 °C P值

P value

活性氧水平
relative ROS level

1 100.0±25.3 113.7±10.0 0.057

10 100.0±37.7 144.8±18.2 0.137

20 100.0±7.5 193.0±14.1 0.001*

细胞活性
cell relative activity

1 100.0±6.6 101.2±5.0 0.806

10 100.0±5.9 98.0±5.3 0.678

20 100.0±12.5 94.7±5.6 0.540

吞噬率/%
the phagocytic rates

1 28.40±4.40 33.24±2.06 0.232

10 30.94±2.33 35.03±3.46 0.238

20 29.02±3.35 33.13±2.55 0.240

DNA损伤
DNA damage

1 100.0±19.5 97.9±13.0 0.882

10 100.0±11.9 99.7±3.4 0.974

20 100.0±23.1 98.2±10.3 0.910

SOD活性/(U/mg prot)
SOD activity

1 97.54±9.23 92.23±17.59 0.563

10 81.11±7.25 80.72±7.70 0.936

20 86.51±18.73 83.48±11.67 0.767

ATP酶活性/(U/mg prot)
ATPase activity

1 0.90±0.08 0.92±0.08 0.701

10 0.98±0.15 1.16±0.07 0.052

20 1.13±0.13 1.07±0.09 0.418

注：活性氧水平、细胞活性、DNA损伤均采用相对值计 (无单位) ，*表示差异显著 (P<0.05)。
Notes: relative ROS level, cell activity and DNA damage extent were measured in relative value (no unit), * indicates a significant difference (P<0.05).
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 2.2    温度升高和游离余氯对泥蚶 ROS水平的

影响

19 °C时，低浓度组和高浓度组泥蚶 ROS水

平第 1、10天和对照组相比无显著差异 (P>0.05)，
第 20天和对照组相比显著升高 (P<0.05)，分别为

对照组的 2.2倍和 6.2倍 (图 1)。29 °C时，低浓度

组泥蚶 ROS水平第 1、10天和对照组相比无显著

差异  (P>0.05)，第 20天和对照组相比显著升高

(P<0.05)，为对照组的 2.9倍。高浓度组泥蚶

ROS水平第 10和 20天和对照组相比显著升高

(P<0.05)，分别为对照组的 2.1和 3.6倍。

双因素方差分析结果显示，第 1和 10天，温

度升高和游离余氯对泥蚶 ROS无交互作用，温度

升高 (1 d： P=0.001；10 d： P=0.000) 和游离余氯

(1 d： P=0.035；10 d： P=0.001) 皆为主效应。第

20天，温度升高和游离余氯浓度对泥蚶 ROS具有

显著交互作用 (F=21.708，P=0.000) (表 2)。

 2.3    温度升高和游离余氯对泥蚶细胞活性的影响

19 °C时，低浓度组泥蚶细胞活性第 20天和

对照组相比显著降低  (P<0.05)，为对照组的

76.1%；高浓度组泥蚶细胞活性第 10、20天和对

照组相比显著降低  (P<0.05)，分别为对照组的

63.1%和 54.2%。29 °C时，低浓度组泥蚶细胞活

性第 1天和对照组相比无显著差异  (P>0.05)，第

10、20天和对照组相比显著降低 (P<0.05)，分别

为对照组的 80.0%和 70.0%；高浓度组泥蚶细胞

活性在第 10、20天显著降低 (P<0.05)，分别为对

照组的 58.4%和 45.2% (图 2)。
双因素方差分析结果显示，第 1、10和 20天，

温度升高和游离余氯对泥蚶细胞活性无显著交互

作用。第 1天时无主效应，第 10、20天时，温度

升高 (1 d： P=0.020；10 d： P=0.001) 和游离余氯

(1 d： P=0.000；10 d： P=0.000) 皆为主效应 (表 2)。

 2.4    温度升高和游离余氯对泥蚶血细胞吞噬率

的影响

19 °C时，第 1、10和 20天对照组泥蚶的血

细胞吞噬率呈现出波动变化，为  (28.4%±4.4%)~
(30.9%±2.3%) (图 3)。低浓度组泥蚶血细胞吞噬率

和对照组相比均无显著差异 (P>0.05)。高浓度组

泥蚶血细胞吞噬率在第 10、20天和对照组相比显

著降低 (P<0.05)，分别为对照组的 56.6%和 60.0%。

29 °C时，第 1、10和 20天对照组泥蚶血细胞吞

噬率呈波动变化，为 (33.1%±2.6%)~(35.0%±3.5% )。
低浓度组泥蚶血细胞吞噬率和对照组相比均无显

著差异 (P>0.05)。高浓度组泥蚶血细胞吞噬率均

显著低于对照组 (P<0.05)，分别为对照组的 33.0%、

44.9%和 45.8%。

双因素方差分析结果显示  (表 2)，第 1天，

温度升高和游离余氯对泥蚶血细胞吞噬活性具有

显著交互作用 (F=8.106，P=0.005)；第 10和 20天，

温度升高和游离余氯对泥蚶血细胞吞噬活性无显

著交互作用，浓度为主效应 (10 d： P=0.000；20 d：
P=0.000)。

 2.5    温度升高和游离余氯对泥蚶 DNA损伤的

影响

19 °C时，低浓度组泥蚶 DNA损伤第 20天

和对照组相比显著升高 (P<0.05)，为对照组的 1.8
倍  (图 4，图 5)。高浓度组泥蚶 DNA损伤第 1、
10和 20天和对照组相比均显著升高 (P<0.05)，分

别为对照组的 2.3、2.6和 6.0倍。29 °C时，低浓

度组泥蚶 DNA损伤均升高，第 1和 20天显著升

高 (P<0.05)，分别为对照组的 1.5和 2.2倍。高浓

度组泥蚶 DNA损伤第 1、10和 20天和对照组相

比均显著升高  (P<0.05)，分别为对照组的 2.7、
4.5和 8.1倍。
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图 1    温度升高和游离余氯对泥蚶活性氧水平的影响

CK.空白对照组，FRC1. 0.33 mg/L浓度组，FRC2. 6.66 mg/L浓度

组。同一温度、时间，不同浓度下，不同字母表示差异显著

(P<0.05)，下同。

Fig. 1　Effect of temperature rise and free residual
chlorine on the ROS level in T. granosa

CK.  blank  control  group,  FRC1.  0.33  mg/L  group,  FRC2.  6.66  mg/L
group; different letters indicate significant differences for different con-
centrations at the same temperature and time (P<0.05), the same below.
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双因素方差分析结果显示，第 1天，温度升

高和游离余氯对泥蚶 DNA损伤无显著交互作用，

浓度为主效应 (P=0.000)。第 10和 20天，温度升

高和游离余氯对泥蚶 DNA损伤具有显著交互作用

(F=26.199，P=0.000；F=31.440，P=0.000) (表 2)。

 2.6    温度升高和游离余氯对泥蚶 SOD活性的

影响

19 °C时，第 1、10和 20天对照组泥蚶体内

SOD活性呈波动变化，范围为  (81.1±7.3)~(97.5±
9.2) U/mg prot，低浓度组泥蚶 SOD活性第 1天和

 

表 2    温度升高和游离余氯对泥蚶氧化响应指标的影响

Tab. 2    Effects of temperature rise and free residual chlorine on oxidative response index of T. granosa

氧化响应指标
oxidative response

取样时间/d
sampling time

因子/交互　factor/interaction

温度升高
temperature rise

余氯浓度
residual chlorine concentration

温度×浓度
temperature×concentration

活性氧水平
relative ROS level

1 F=16.259

P=0.002*
F=3.752

P=0.054

F=0.104

P=0.902
10 F=43.623

P=0.000**
F=22.737

P=0.000**
F=5.648

P=0.019*

20 F=95.411

P=0.000**
F=286.470

P=0.000**
F=21.708

P=0.000**

细胞相对活性
cell relative activity

1 F=0.002

P=0.967

F=1.483

P=0.266

F=0.035

P=0.966
10 F=8.123

P=0.015*
F=67.235

P=0.000**
F=2.210

P=0.152

20 F=7.749

P=0.017*
F=83.356

P=0.000**
F=0.279

P=0.761

吞噬率/%
the phagocytic rates

1 F=0.380

P=0.549

F=26.698

P=0.000**
F=8.106

P=0.006*

10 F=0.779

P=0.395

F=24.002

P=0.000**
F=0.787

P=0.477

20 F=0.004

P=0.950

F=30.539

P=0.000**
F=1.300

P=0.308

DNA损伤
DNA damage

1 F=1.694

P=0.217

F=95.471

P=0.000**
F=1.403

P=0.283
10 F=20.290

P=0.001*
F=160.119

P=0.000**
F=26.059

P=0.000**

20 F=41.253

P=0.000**
F=958.444

P=0.000**
F=28.287

P=0.000**

SOD活性/(U/mg prot)
SOD activity

1 F=0.134

P=0.717

F=13.550

P=0.000**
F=6.550

P=0.005
10 F=1.019

P=0.323

F=6.418

P=0.006*
F=1.016

P=0.377

20 F=0.503

P=0.485

F=18.020

P=0.000**
F=0.473

P=0.629

ATP酶活性/(U/mg prot)
ATPase activity

1 F=0.131

P=0.721

F=5.729

P=0.009*
F=0.029

P=0.971
10 F=0.208

P=0.653

F=46.131

P=0.000**
F=11.536

P=0.000**

20 F=0.039

P=0.845

F=60.863

P=0.000**
F=0.815

P=0.455

注：*表示差异显著(P<0.05)，**表示差异极显著(P<0.01)。
Notes: * indicates a significant difference (P<0.05) , ** indicates an extremely significant difference (P<0.01).
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对照组相比显著降低  (P<0.05)，为对照组的

55.6% (图 6)。高浓度组 SOD活性在第 20天时显

著低于对照组  (P<0.05)，为对照组的 55.4%。

29 °C时，第 1、10和 20天对照组泥蚶体内 SOD
活性呈波动变化，范围为 (80.7±7.7)~(92.2±17.59)
U/mg prot，低浓度组泥蚶 SOD活性与对照组相比

差异均不显著 (P>0.05)。高浓度组 SOD活性均显

著低于对照组 (P<0.05)，在胁迫末期 (20 d) 时降

至最小值，仅为对照组的 43.6%。

双因素方差分析结果显示  (表 2)，第 1、10
和 20天，温度升高和游离余氯对泥蚶 SOD活性

均无显著交互作用。第 10天时无主效应，第 1
和 20天时，主效应为游离余氯  (1 d：  P=0.001；
20 d： P=0.000)。
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图 2    温度升高和游离余氯对泥蚶细胞活性的影响

Fig. 2　Effect of temperature rise and free residual
chlorine on the cell activity in T. granosa

 

40

30

20

10血
细
胞
吞
噬
率

/%

th
e 

h
ag

o
cy

to
si

s 
ra

te
 o

f 
h
em

o
cy

te
s

1 d 10 d 20 d 1 d 10 d 20 d

组别
groups

19 °C 29 °C

a
a

a

a a a

a a
a

a
a a

a

bb

b

b b

CK FRC1 FRC2

 
图 3    温度升高和游离余氯对泥蚶血细胞吞噬率的影响

Fig. 3　Effect of temperature rise and
free residual chlorine on the phagocytic rates of

hemocytes in T. granosa
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图 4    温度升高和游离余氯对泥蚶 DNA损伤的影响

Fig. 4　Effect of temperature rise and free residual
chlorine on the DNA damage in T. granosa
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图 5    彗星实验图片

Fig. 5　Pictures from comet assay
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 2.7    温度升高和游离余氯对泥蚶 Na+/K+-ATP
酶活性的影响

19 °C时，第 1 、10和 20天对照组泥蚶体内

ATP酶活性呈波动变化，为  (0.90±0.08)~  (1.13±
0.13) U/mg prot，低浓度组泥蚶 ATP酶活性在第

20天时显著低于对照组  (P<0.05)，为对照组的

70.8% (图 7)。高浓度组 ATP酶活性均在第 10和

20天时显著低于对照组  (P<0.05)，在胁迫末期

(20 d) 降至最小值，仅为对照组的 51.9%。29 °C
时，第 1、10和 20天对照组泥蚶体内 ATP酶活

性呈波动变化，为 (0.92±0.08)~(1.16±0.07) U/mg prot，
低浓度组泥蚶 ATP酶活性在第 1、10和 20天均

低于对照组。高浓度组 ATP酶活性均显著低于对

照组 (P<0.05)，在第 10天时降至最小值，仅为对

照组的 46.7%。

双因素方差分析结果显示，第 10天，温度升

高和游离余氯对泥蚶 ATP酶活性具有显著交互作

用 (F=11.536，P=0.000)；第 1和 20天，温度升高

和游离余氯对泥蚶 ATP酶活性无显著交互作用

(表 2)，主效应为游离余氯 (1 d： P=0.006；20 d：
P=0.000)。

 3    讨论

 3.1    温度升高对泥蚶的氧化胁迫效应

温度升高会诱导生物体产生 ROS，激活

SOD活性，ROS积累过多会导致生物氧化应激[17]。

本研究中，19和 29 °C下，ROS水平在第 20天时

显著升高，SOD活性及其他氧化响应指标未见显

著变化，可能的原因：①泥蚶是一种广温性双壳

贝类，适宜生长温度为 13~30 °C[18]，对温度的适

应范围较广。19~29 °C时，泥蚶未产生显著的

SOD活性及其他氧化响应指标变化。廖一波等[19]

对 4种主要经济贝类的热耐受研究中，也指出泥

蚶>长牡蛎 (Crassostrea gigas)>缢蛏 (Sinonovacula
constricta)>贻贝 (Mytilus edulis)，在夏季自然起始

水温为 28  °C时，泥蚶的 48  h临界热最大值

(CTMax，critical thermal maxima)为 39.3 °C。②蚶

类有一定的自我调节能力[20]，温度对机体造成的

影响会随着时间延长而逐渐恢复。本研究中泥蚶

在开始游离余氯胁迫前进行了升温暂养，使泥蚶

处于 19和 29 °C下，其体内 SOD活性及其他氧

化响应指标可能已恢复至平衡状态。

 3.2    游离余氯对泥蚶的氧化胁迫效应

 游离余氯对泥蚶 ROS水平的影响　　游离

余氯即次氯酸钠是一种强氧化剂，当生物体处于

游离余氯胁迫环境时，机体可通过产生 ROS，如

O–
2·、H2O2、·OH、NO·等代谢外源伤害，此过程

会伴随由未成对电子构成的自由基，过量的自由

基会造成机体的过氧化胁迫，进而诱发氧化损伤，

造成毒性影响[21]。已有研究中发现，菲和镉单一

及复合污染能诱导毛蚶体内 ROS含量的增加及

GSH含量、GST活性的降低[22]。H2O2 处理人神经

母细胞瘤系 SH-SY5Y后，细胞生存率明显下降，

细胞内 ATP和 GSH含量显著下降，细胞产生了

较高的氧化反应[23]。在极低浓度的 NaClO胁迫下，

铜绿微囊藻和小球藻细胞内的 ROS也会增加，氯
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图 6    温度升高和游离余氯对泥蚶 SOD活性的影响

Fig. 6　Effect of temperature rise and free residual
chlorine on the SOD activity in T. granosa
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图 7    温度升高和游离余氯对泥蚶 ATP酶活性的影响

Fig. 7　Effect of temperature rise and free residual
chlorine on the ATPase activity in T. granosa
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可穿透细胞氧化色素，干扰光合作用，影响酯酶

活性 [4]。因此，ROS生成及其含量增加和氧化作

用有关 [21-22]。本研究中随着游离余氯胁迫时间的

延长，泥蚶体内的 ROS水平升高，高浓度组

ROS增量整体显著高于对照组，存在时间-效应关

系和剂量-效应关系，表现出较强的毒性影响潜力

和氧化胁迫反应。

 游离余氯对泥蚶 SOD活性的影响　　SOD
作为抗氧化系统中的重要指标，在维持机体氧化

与抗氧化平衡中起着关键作用[24]。它可以催化超

氧阴离子与氢离子反应生成过氧化氢，从而解除

活性氧对机体的损伤[25]。有研究表明，当受到外

界环境干扰时，低浓度毒物可使生物体内的 SOD
活性升高，此种现象称为“毒物兴奋效应” [26]，高

浓度毒物则呈现出抑制 SOD活性趋势。在本研究

所设置的浓度下，在暴露的开始阶段，泥蚶 SOD
活性呈下降趋势，随着暴露时间延长，游离余氯

浓度越高，SOD活性越小。游离余氯胁迫下，泥

蚶体内产生大量的 ROS，一方面与细胞内的 SOD
产生反应，迅速消耗 SOD；另一方面，ROS会诱

导产生 SOD，推测诱导产生的 SOD低于消耗量，

因此 SOD活性下降。在对其他水产动物 SOD活

性的研究中，也发现类似现象，斑马鱼 (Danio
rerio)暴露于氧化乐果，SOD活性降低 [27]。随着

氯氰菊酯浓度的增加，日本沼虾 (Macrobrachium
nipponense) SOD活性急剧下降[28]。淡水双壳贝类

被转移到污染地时，其体内 SOD活性显著下降[29]。

推测 SOD活性在面临氧化性较高的毒物时，敏感

值较低，在较低的毒物浓度下，SOD活性呈现出

被抑制的趋势。

 游离余氯对泥蚶 ATP酶活性的影响　　

Na+/K+-ATP酶又称三磷酸腺苷酶，是一种广泛存

在于真核动物中的膜蛋白酶[30]，能将三磷酸腺苷

(ATP) 催化水解为二磷酸腺苷 (ADP) 和磷酸根离

子，可为生物提供能量，在维持体内 K+和 Na+浓
度跨膜运输平衡过程中发挥重要作用。 ATP酶活

性是表征细胞活力和毒物学工具的一个重要指标，

而且 ATP酶是有机氯毒物的目标酶[25]，ATP酶属

于一种细胞膜蛋白，其三维结构的维持高度依赖

于所结合的脂，细胞膜的流动性也保证了 ATP酶

起作用，因此脂的破坏将导致酶的结构改变，细

胞膜结构或流动性改变会导致 ATP酶损失或者活

性下降。在本研究中，游离余氯胁迫使泥蚶体内

产生大量的活性氧自由基，使生物膜产生脂质过

氧化，破坏了生物脂的生物功能，从而影响 ATP
酶活性。

 游离余氯对泥蚶血细胞吞噬率的影响　　

本研究发现泥蚶血细胞的细胞活性下降、ROS水

平升高、ATP酶活性下降。这三个生理生化指标

的变化可能是造成泥蚶血细胞吞噬率下降的原因。

首先，游离余氯胁迫使泥蚶血细胞细胞活性显著

下降。吞噬是一个完全依赖细胞的生理活动过程，

细胞的生理状态会直接影响吞噬效率。当细胞的

活性下降，其表面的受体识别能力下降、细胞膜

内陷，进而导致吞噬活性的下降。其次，强氧化

性是游离余氯最显著的特点，一旦进入机体，会

诱导机体产生大量的 ROS，对血细胞造成伤害。

泥蚶的血细胞细胞膜是典型的磷脂双分子膜，含

有大量不饱和脂肪酸，这些不饱和脂肪酸极易受

到强氧化物的侵蚀而导致正常功能受损[31]。正常

的吞噬过程离不开细胞膜包裹内吞步骤，这一步

骤十分依赖细胞膜的伸展功能，因此游离余氯引

起泥蚶体内 ROS的升高很可能是血细胞吞噬率下

降的原因之一。第三，游离余氯胁迫使泥蚶体内

ATP酶活性下降。吞噬是依赖能量的生理活动过

程，ATP酶活性会直接影响吞噬效率，供能不足

导致吞噬活性下降。

 游离余氯对泥蚶 DNA损伤的影响　　有研

究表明，毒性物质胁迫可以通过产生 ROS进而造

成 DNA损伤[32-35]，本研究结果也证实了这一现象。

1 μmol/L 1-硝基芘染毒下，人肺上皮细胞 A549内

ROS显著增加，导致 DNA损伤，且呈现剂量-效
应关系[32]。BDE-47能够诱导斑马鱼胚胎、幼体产

生氧化响应，ROS是诱发胚胎发生 DNA损伤的

导火索，且损伤程度伴随着 ROS水平的升高而升

高[34]。另外，在杨金辉[35] 的研究中发现，蚯蚓的

DNA损伤与液体离子 PF6和 CL的浓度和处理时

间存在剂量-效应和时间-效应关系，与本研究结

果一致。在慢性和亚慢性胁迫时，如果产生的

ROS自由基太多或者由于抗氧化剂太少，就会造

成慢性的永久损伤[36]。ROS自由基中的羟自由基

可修饰碱基，对胸腺嘧啶的 5, 6-双键进行加成，

形成胸腺嘧啶自由基。ROS自由基还会造成键的

断裂，自由基从 DNA的戊糖夺取了氢原子，使之

在 C4位置形成具有未配对电子的自由基，然后，

此自由基又在 β-位置发生键的断裂[37]，造成 DNA
损伤。
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 3.3    温度升高和游离余氯联合对泥蚶的氧化胁

迫效应

目前，多数研究主要关注单一环境压力对海

洋生物的影响，多重压力下的耦合效应往往产生

更大的环境压力，这类研究同样值得关注。本研

究以泥蚶为对象，开展多重压力耦合效应研究，

旨在阐明温度升高和游离余氯联合对泥蚶的氧化

胁迫作用。研究结果显示，温度升高和游离余氯

联合胁迫作用时，对泥蚶 ROS水平、血细胞吞噬

率、DNA损伤、ATP酶活性均产生了显著交互作

用，温度的升高加剧了游离余氯对泥蚶的氧化胁

迫。但对细胞活性、SOD活性无显著交互作用，

说明温度升高和游离余氯之间的交互关系会因指

标的不同而有所不同。在不同温度下，汞对草鱼

(Ctenopharyngodon idella)的毒理学影响研究中，

发现温度和汞对 PK和 CAT这两种酶活性产生了

显著交互作用，但对 SOD和 MT等活性无显著交

互作用[38]，也证明了多重压力下的耦合效应往往

产生更大的环境压力。总体来说，温度越高，可

能会使游离余氯的毒性作用增强，从而产生更大

的生物毒性，故在余氯排放海域，夏季会比冬季

对泥蚶产生更大的氧化胁迫。

综上，单一温度升高胁迫下，只在第 20天时

对泥蚶体内 ROS水平造成显著影响，温度越高，

ROS水平越高。游离余氯能对泥蚶体内产生一定

程度的氧化胁迫，刺激泥蚶产生大量 ROS，通过

激活和消耗一定量的 SOD和 ATP酶来消除过量

的 ROS，但是，过量的 ROS可造成细胞活力下降、

细胞吞噬率下降、DNA损伤等一系列氧化还原反

应。温度升高和游离余氯联合胁迫作用时，温度

的升高加剧了游离余氯对泥蚶的氧化胁迫作用。

本研究可为揭示海洋生物在温度升高和游离余氯

复合污染中而导致的氧化胁迫毒性提供线索，并

且为生态风险评估提供科学依据。

（作者声明本文无实际或潜在的利益冲突）
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Oxidative stress effect of temperature rise and free residual chlorine on
Tegillarca granosa

CHEN Lin 1,2,     TENG Shuangshuang 1,     HU Gaoyu 1,     XIAO Guoqiang 1,2,     HUANG Xiaolin 1*

(1. Wenzhou Key Laboratory of Marine Biological Genetics and Breeding,
Zhejiang Key Laboratory of Exploitation and Preservation of Coastal Bio-Resource,

Zhejiang Mariculture Research Institute, Wenzhou　325005, China;
2. National Engineering Research Center for Marine Aquaculture,

Zhejiang Ocean University, Zhoushan　316022, China)

Abstract: To investigate  the  effects  of  warm waste  water  from nuclear  power  plants  on  the  long-term stress  of
aquatic animals, the influence of free residual chlorine on the oxidative pressure of Tegillarca granosa under dif-
ferent temperature conditions were studied through laboratory simulation. Water temperatures were set as 19 and
29 °C, and two different  gradients of  free residual  chlorine concentration were set  as 0.33 mg/L and 6.66 mg/L.
The results showed that: ① water temperature can significantly affect the ROS level. The higher the temperature,
the higher the ROS level. ② the ROS level and DNA damage of T. granosa  in 0.33 mg/L group were increased
significantly on day 20, which were 2.2, 2.9 times and 1.8, 2.2 times higher than those in the control group at 19
and 29 °C,  respectively;  the  cell  activity,  ATPase activity  and SOD enzyme activity  decreased significantly;  the
ROS level in the 6.66 mg/L group increased significantly on day 20, which was 6.2 and 3.6 times higher than that
in the control group at 19 °C and 29 °C, respectively; the DNA damage increased; the cell activity, hemocyte pha-
gocytosis rate and ATPase activity decreased; SOD enzyme activity decreased to the minimum value of (36.4±8.4)
U/(mg prot) at 29 °C on day 20. ③ two-factor analysis of variance showed that water temperature and free resid-
ual chlorine had significant interaction on the parameters of ROS level, DNA damage, hemocyte phagocytosis rate
and ATPase activity. The results indicate that free residual chlorine can significantly increase the ROS level and
the DNA damage of T. granosa. The combined exposure of water temperature and residual chlorine, which caused
greater stress pressure on T. granosa, affected the physiological processes related to oxidative stress. In the resid-
ual chlorine discharge area, greater oxidative stress would be faced by T. granosa in summer than in winter. This
study can give a reference for studying oxidative stress toxicity of marine organisms exposed to warm water com-
bined with residual chlorine, and provide scientific basis for ecological risk assessment.

Key words: Tegillarca granosa; warm drainage pollution of  nuclear  power plant;  temperature  rise;  free  residual
chlorine; oxidative response; ROS; DNA damage
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